Model Performance Technical Note

Like any design instrument, Autodesk® Revit® performance can depend as much on the knowledge, skill and practices of its users as on the hardware environment provided for the software. To address both areas which can affect model performance, the Autodesk® Revit® team has assembled this collection of hardware requirements, recommendations and modeling best practices as researched by both internal development and our community of dedicated customers.

Just as no two buildings are identical, no two models of differing buildings are precisely identical in the tactics and strategies that will yield the most robust performance, but the recommendations that follow are designed as a set of tools to be selected singly or in combination to help produce in a timely fashion models that are consistent, computable, and communicative of design intent.

Many people on the Autodesk® Revit® team from Support, Quality Assurance, Development, Consulting and Product Management contributed to this document, but a number of recommendations arose from the community of Autodesk® Revit® users, who generously contributed their time and expertise to their peers in a number of forums, and urged Autodesk® to help share their knowledge with an even wider audience.

As always, our thanks go to our customers, who are part of the team helping to improve Revit® with every release through their insightful comments and suggestions.
Contents
Hardware Requirements for Autodesk Revit 2016 ................................................................. 4
Detailed Hardware Recommendations .................................................................................. 4
Central Processing Unit (CPU) ...................................................................................... 4
Multiple-Core / Multiple Processors .............................................................................. 4
CPU Performance ........................................................................................................ 4
L2 Cache ....................................................................................................................... 5
Hard Drive .................................................................................................................. 5
Defragmentation .......................................................................................................... 5
Video Cards ................................................................................................................ 6
Hardware Acceleration ................................................................................................. 6
Memory ....................................................................................................................... 7
Installed RAM ............................................................................................................ 7
Management .............................................................................................................. 7
Optimizing OS for Performance .................................................................................. 7
Network Recommendations ......................................................................................... 11
Data Server Specification ......................................................................................... 11
Remote Desktop Sharing ............................................................................................ 12
Revit Server .............................................................................................................. 12
Revit Model Optimization and Best Practices ........................................................... 13
General Guidelines .................................................................................................. 13
Arrays ...................................................................................................................... 13
Constraints ............................................................................................................... 14
Design Options ......................................................................................................... 14
DWG Files ............................................................................................................... 14
Family Creation ....................................................................................................... 14
Importing & Linking ................................................................................................. 16
Modeling Economically ............................................................................................ 16
Project Templates ..................................................................................................... 17
Raster Images .......................................................................................................... 17
Rooms and Spaces ................................................................................................... 17
Views ....................................................................................................................... 18
Worksets ................................................................................................................ 21
Worksharing ............................................................................................................ 22
Analytical Model Management ............................................................................... 23
Connection Elements ................................................................................................................................................... 23
Revit MEP Optimization and Best Practices ................................................................................................................. 24
Interacting with Autodesk Support................................................................................................................................ 27
Hardware Requirements for Autodesk Revit 2016

For current system requirements, see this help page:


Detailed Hardware Recommendations

Central Processing Unit (CPU)

Autodesk Revit is a computationally intensive application, and will benefit from a high-performance CPU.

- Most users select 3+GHz processors with multiple cores.
- Some customers have gained performance benefits through moderate overclocking of the CPU. Customers should consult with manufacturers to determine safe values of processor overclocking.
- Centrino/Pentium-M/Core Intel processors for laptops work well with Revit, and are recommended for laptops given their higher efficiency and reduced heat output. Multiply a Centrino/Pentium-M's processor speed by 1.6 to find its approximately equivalent Pentium 4 speed.

Multiple-Core / Multiple Processors

- Although the Revit platform is not fully optimized for multi-threading, multiple-core processors reduce cycle use by other applications running concurrently. Some reports show as much as a 20% increase in Revit performance in a multi-core or multiple processor environment.
- Many areas of Revit take advantage of multiple cores. These include:
  - Vector printing
  - 2D Vector Export such as DWG and DWF
  - Mental Ray Rendering
  - Wall Join representation in plan and section views.
  - Loading elements into memory. Reduces view open times when elements are displayed for the first time in a session.
  - Parallel computation of silhouette edges (outlines of a curved surfaces) used when navigating perspective 3D views.
  - Translation of high level graphical representation of model elements and annotations into display lists optimized for given graphics card. Engaged when opening views or changing view properties.
  - File Open and Save
  - Point Cloud Data Display

- Additional multi-threaded capabilities are added with every release.

CPU Performance

A variety of benchmarks are available to compare CPU performance. The following links are provided as a service...
to customers who may wish do further research. Autodesk makes no warranties about the accuracy or veracity of this data:

- [http://www.cpubenchmark.net/](http://www.cpubenchmark.net/)
- [http://www.spec.org/benchmarks.html](http://www.spec.org/benchmarks.html)

### L2 Cache

Because of their substantial performance benefits, Autodesk strongly recommends CPUs that include an L2 cache. Larger L2 caches of 2MB and beyond can provide performance benefits for computationally-intensive operations such as model regeneration.

Processors with a smaller or no L2 cache, such as the Atom and Sempron models, are not recommended for use with Revit.

### Hard Drive

#### Speed

Workstation hard drive speed affects Revit performance during model load, local model save, and hard disk swapping managed by the Microsoft Windows operating system.

If higher performance is desired during these operations, a faster hard drive may provide some benefit, however the Revit team considers this workstation improvement of lower priority when compared with performance enhancements related to CPU speed and increasing available RAM.

#### Type

SCSI or SATA drives are optional for day-to-day use of Revit.

#### Configuration

For the Windows swap file, it is recommended that you set both the minimum and maximum settings to the same value, which should be at least twice the value of your installed RAM. This approach will prevent Windows from changing the size of the swap file while you are working.

#### Defragmentation

It is recommended that you defragment local PCs and servers periodically. Highly fragmented drives can noticeably slow PC performance.
Video Cards

- Autodesk strongly recommends dedicated video cards supporting DirectX 11 or later.
- Consider video cards designed to support CAD applications.
- Integrated video support should be avoided because these cards make use of machine RAM rather than on-card memory.
- Medium range video cards may perform as well as more expensive cards.
- To find video cards and drivers that have been certified to work with Revit, refer to www.autodesk.com/graphics-hardware

Hardware Acceleration

To take full advantage of hardware acceleration, please follow these steps:
1. Go to main “R” menu
2. Open the “Options”
3. Select the “Graphics” tab.
4. Check the “Use Hardware Acceleration” box, illustrated below.
5. Close and restart Revit.

Graphics Mode
- Use Hardware Acceleration (Direct3D®)
- Use Optimized View Navigation
- Smooth lines with anti-aliasing
- Allow control for each view in the Graphic Display Options dialog
- Use for all views (control for each view is disabled)
Memory

Installed RAM

- Minimum RAM is 4 GB but 16GB is recommended. Larger, more complex models will make use of more RAM.
- The quantity of RAM available to Revit is partially dependent on the Windows operating system environment.
- The amount of local machine RAM required is approximately 20 times the size of your compacted central project file. Inadequate RAM can significantly hurt model performance.
- Revit rendering now operates in a separate process, and could benefit from memory available beyond the limits accessible by the Revit application itself.
- Memory specifications vary, but higher speed low latency dual channel RAM can yield significant performance benefits.

Management

Revit maintains model data in memory and hard disk caches to increase performance against repeated data access. As a consequence of extended model manipulation, Revit performance may benefit from an application restart, especially before triggering the following memory-intensive tasks:

- Printing
- Rendering
- Exporting
- Upgrading models to the current Revit version

Optimizing OS for Performance

Verify that the paging file size is optimized for your system. The paging file should be at least the size that is recommended for Windows and at most twice the size of installed RAM. Larger page files may provide more memory for the Revit platform, but system performance could degrade noticeably with expanded page files.

To adjust paging file size, follow these steps:

1. On the Start menu (Windows), click Settings > Control Panel.
3. Click System
4. Click Advanced System Settings
5. In the System Properties dialog box, click the Advanced tab.

![System Properties](image)

6. Under Performance, click Settings.
7. In the Performance Options dialog box, click the Advanced tab.
8. On the Advanced tab, under Virtual Memory, click Change.
9. In the Virtual Memory dialog box, change the Initial and Max values to 8184 (2 * 4GB) for a 4GB machine.

10. Click Set.
11. Click OK to close the Virtual Memory dialog.
12. Click Apply.
13. Click the Visual Effects Tab.

14. Select Custom.

15. Clear the Face or slide menus into view option.

16. Clear the Show window content while dragging option.

17. Clear the Slide open combo boxes option.

18. Click Apply.

19. Click OK to close each dialog.
Network Recommendations

The Revit team strongly recommends a gigabit-speed local area network (LAN) for workshared projects. The gigabit threshold should be served at all stages of the network, including:

- Gigabit-speed Ethernet cards at the desktop
- Category 5e or Category 6 cabling
- Gigabit switches
- One or more gigabit Ethernet cards at the data storage device (server or Storage Area Network) housing the central model

When serving a geographically diverse project team across a wide area network (WAN), the Revit team strongly recommends traffic acceleration as provided by several appliances currently on the market.

Data Server Specification

Servers storing Revit central files can benefit from:

- Hard drive speeds as fast as economically practical
- Multiple processors
Remote Desktop Sharing

An alternative or additional strategy beyond increasing network and server performance can be remote desktop sharing, where keystrokes, mouse clicks and screen paints are transmitted between remote locations and local desktops dedicated to offsite control for Revit model interaction, as in the following diagram:


Revit Server

Revit Server is the server application for Revit Architecture, Revit Structure, Revit MEP, and Autodesk Revit. It is the foundation for server-based worksharing for Revit projects. The Revit Server network architecture is designed to support worksharing of multiple central models across a wide area network (WAN) and maximize performance of Revit worksharing for distributed teams.
Revit Model Optimization and Best Practices

General Guidelines

In general, the following characteristics of a Revit model can affect performance:

- Complex geometry
- Multiple parametric relationships
- Multiple constraints
- Graphically complex views
- Linked files

The following sections will examine many aspects of modeling and recommend certain practices in particular situations, but examining a model and its constituent families with these factors in mind will aid in optimizing model performance.

Arrays

Arrays can be used to copy and associate objects together. After the array is deployed, performance may be improved by ungrouping the arrayed, removing the parametric associations of the copied objects.

The Group And Associate checkbox may also be cleared before when creating the array to attain the same result.
Constraints

Minimal constraints will help prevent:

- “Can’t keep joined” errors to a minimum when moving objects.
- Workset sharing issues where a user may unknowingly take ownership of an object.

Design Options

- Limit the use of rooms in design options because additional time is required to detect room option conflicts.
- Use separate models for variations of entire building wings.
- Preserve design options only as long as they are useful to the project. Even though options may not be active and visible, when changes are made within the main model all design options will update.
- Consider whether options should be preserved long term in separate models, which can be linked as needed.

DWG Files

- Minimize the number of linked or imported DWG files.
- Avoid importing unnecessary data like hatching or AutoCAD-specific linework such as construction lines. Delete unnecessary parts and layers of the DWG file within AutoCAD and import only the cleaned, smaller DWG.
- Avoid exploding the geometry imported from DWG files. The exploding operation within Revit can change a DWG from a single managed element to hundreds or thousands of additional elements depending on the number of entities in the imported DWG. Increasing numbers of elements will affect regeneration, manipulation and view update time.
- Only link essential DWG files into necessary views. Unlink files that are no longer necessary.
- Switch off visibility of 2D AutoCAD DWGs in perpendicular views. A 2D AutoCAD file linked into a plan view will show as collinear lines in elevation, leading to performance degradation.

Family Creation

- Because families are optimized for repetition, create a family component instead of in-place families when components are going to be repeated. When an in-place family is copied (which may already be problematic), it makes an entirely new entity each time, as opposed to referencing the information from the first instance.
- Limit the use of detailed/nested/parameterized families to necessities.
- Families are “lighter” than groups. Use families instead of groups, where possible. Groups are very powerful, but updating large quantities of group instances consumes significant computing resources.
- Where possible, avoid widespread use of voids in family geometry.
• Where possible, avoid arrays and formulas.

• Use symbolic lines and masking regions instead of geometry in plan views to show simple geometric representations. This allows Revit to avoid processing complex geometry when it is not necessary.

• Parametric families place a greater computational burden on the model than static families. Consider carefully whether a family needs parametric flexibility and confine that flexibility to necessary adjustments.

• Families that cut their hosts consume significant computing resources on regeneration when compared to families that reside on a surface without cutting the host. Consider modeling building components such as HVAC registers as 2D ceiling- or face-based families to reduce penetration calculations.

• Model designs selectively. Objects only viewed from certain points need only be modeled to appear correct in those selected views. The following illustrations show two families, both designed to represent the same toilet in plan:

The 3D toilet below is completely modeled: The 2D version of the toilet is invisible in a 3D view. There are only views available of the toilet in elevation and plan, which is sufficient for most project needs.

The 2D version of this family is 20% smaller than the 3D version. Multiplied over an entire project, a larger family can add significantly to a model’s size and computational burden.
Carefully consider what to model. Performance gains may be found as much in the construction of individual families as in other modeling practices.

Importing & Linking

- Unload links of all types if not used. Temporarily unload links if not needed in the view and reload them as required. This should limit memory resources necessary to open the file.

- If the link is located on the network, importing rather than linking may improve performance.

- Host files containing RVT file links will consume more memory on version upgrade than files lacking RVT links. Upgrade links before upgrading the host file, or if necessary, unload all RVT links before upgrading the host file.

- Large projects may benefit from breaking a model into separate project files and linking them into a single central file and assigning each model to a workset (see Worksets section). Some typical cleavage points to divide a single project into multiple models include:
  - Separate buildings
  - Building core
  - Building shell
  - Interiors
  - Expansion joints
  - Individual towers
  - Parking structure(s)

Modeling Economically

- Minimize geometric detail that will be invisible at the chosen output scale. The necessary level of detail in a given model can often be conveyed to a team in terms of a commonly understood drawing scale, such “Provide detail to a ¼” level of detail” or some other commonly employed measure of scale. As much as possible, leverage the project team’s understanding of typical 2D drawing conventions to invest the correct level of complexity into the model.

- Until wall, roof, window and door type construction are determined, use the generic versions of these elements which incorporate less geometry. Unless material use or other types of analysis will be applied to the model, consider that a generic wall may be sufficient for some projects or project areas.

- Consistent customer practice is to break up a large model into multiple files of about 200 MB for 64-bit Revit, and 160 MB for 32-bit, and link together the resulting project files. This procedure works best if the user can work on one file while the other links are unloaded for a majority of the time. Engineering consumers of architectural models may have to maintain one or more constantly loaded links, which may affect model size estimation and thresholds for those disciplines.

- When creating detail views, model hatches with filled regions not lines.

- Limit joined geometry to necessities.

- Remove unneeded area schemes.
• Avoid maintaining unnecessary groups. Delete unused groups from the Project Browser.

• Regularly purge unused objects. Since purged objects cannot be recovered, you may wish to make a backup of the project before purging.

• Regularly review and fix warnings.

• Railings:
  o Avoid use of railings for extensive fences or separation systems and limit the visibility of such elements. There is no warning offered by Revit, but performance is impacted because of the number of lines required to generate each railing element.
  o If a lengthy railing element is desired, consider modeling a simplified railing representation, relying on railing details to fully describe the design.

• Like railings, stairs are complex elements, but may not be easily simplified. Confine stair visibility to essential views.

• Parts and Assemblies
  o Limit the creation of parts and assemblies to necessary elements to avoid overloading your model with unneeded detail.
  o Consider creating parts in a separate model and linking in the original.

• Utilize rebar sets instead of individual rebar elements where possible.

**Project Templates**

• Avoid populating project templates with an excessive number of families that may or may not be useful for every project. Favor a minimal rather than a comprehensive template.

**Raster Images**

• Remove unneeded raster images and renderings. Raster images represent a performance and file size cost which should be minimized.

• Monochrome raster images are smaller than color images. Save black and white raster images as 1 bit per pixel format instead of JPG or TIF. MS Paint refers to this format as Monochrome Bitmap.

• Large raster images, such as logos scaled down to fit into title blocks, will still retain the original file size. Consider creating a smaller, simplified image for import into Revit.

**Rooms and Spaces**

• Only select the Room Bounding option for linked files if they are absolutely needed to bound volumes (rooms and spaces). Revit will need to process these additional boundaries, which can affect model performance. This option is a type parameter of the linked file.

• Promptly resolve warnings about room boundaries overlapping.
If you have two levels with the same elevation, Revit will perform better if all rooms are placed on one of the two levels, rather than dividing the same rooms between the two levels.

Avoid coincident room separation lines overlapping each other and overlapping walls. To locate room separation lines in a model, create a wireframe view template with walls and room or space separation lines visible.

Set room or space separation line color to red with a heavy line weight so they are easy to identify.

Place room separation lines on one workset for better control. (see Worksets section).

Turning off volume computation can improve performance but will disable much of the volume analytical functionality in Revit MEP. When volume computation is off, Revit will represent rooms as simple extrusions, without considering ceilings, roofs, floors, or other upper or lower boundaries. Because volume computations may affect the performance of your Revit project, they are disabled by default, except in Revit MEP where the setting is enabled. Turn on volume computations when you need to:

- Show more accurate room color fills in section views.
- Have Revit compute the volume numbers for each room prior to printing scheduled room volumes.
- Export a gbXML file.
- Perform building performance analysis.
- Account for the location of elements in volumes based upon the bounded volume geometry.

To change the room volume calculation settings, follow these steps:

1. Click Architecture tab in the ribbon, then expand Room and Area tools, and select Area and Volume Computations.
2. On the Computations tab of the Area and Volume Computations dialog, under Volume Computations, select Areas only or Areas and Volumes.
3. Click OK.

Views

- Set a drafting view with few if any elements as the starting view to improve the performance of opening the project (Manage tab ➤ Manage Project panel ➤ Starting View).
- Minimize view depth where possible in elevation, plan, and section views so that geometry hidden by other elements in the view does not affect the view drawing performance.
- Consider back clipping views to reduce the quantity of geometry maintained in a view. Often the overhead associated with additional object cutting due to back clipping is more than offset by the resulting reduced geometry maintenance.
• Use section boxes to limit visible geometry when working in a 3D view.

• Minimize view quantity to help reduce model size. To optimize static models to be linked into active models (for instance, in the case of an existing contextual building model adjoined to a model of new construction), delete as many views as possible from the static model to be linked.

• Use “Wireframe” or “Shading” display modes when working in a linked file environment.

• Avoid hiding large quantities of individual elements in views.

• Turn off unnecessary categories in Visibility/Graphic and templates.

• “Paste aligned” into closed views will open and close the target views. When repeating such an operation several times, performance is improved by opening all the target views before beginning the sequence of paste operations.

• Zoom in to speed up drawing and snapping.

• Clear the “Snap to Remote Objects” setting in the snap dialog (Manage Tab -> Settings panel -> Snaps) if you have a very dense view and snap lines appear to be shooting off in all directions.

• Close unnecessary windows. When working in a 3D view, most of the file is placed into RAM. It is also recommended that these views should be closed when saving to central, since Revit will update this complex view as part of the save process.

• Revit will update all currently open views affected by changes in the model. Often, users will not realize that half a dozen or more views are currently open. In the following illustration, although the current view appears relatively simple, the Window menu shows there are a number of other views open. Selecting “Close Hidden Windows” will close the concealed views, allowing Revit to update only the current view with changes until other views are reopened.
• Assign the proper level of visual detail to a given view. In a 1/8” plan view, assigning a “fine” level of display detail may be unnecessary. Plan views with fine and medium detail level are slow to open if there are many wall join layers to route. Favor a “Coarse” view setting unless required to show greater detail.

• Turn off shadows in views where they are unnecessary.

• Turn off shadows before printing views if not absolutely necessary.

• The Use Optimized View Navigation setting in R -> Options -> Graphics will reduce the amount of information drawn during view navigation and optimize the speed when panning, zooming, and orbiting the model.
Worksets

- Revit originally implemented worksets as a mechanism to enable multiple users to collaborate on a single model by taking temporary ownership of user-defined element groups. “Checking out” a workset prevented other users from editing any part of that workset until control was relinquished on a “Save to Central” operation.

- Today, Revit has transparent element borrowing, which automatically assigns ownership of an edited element to a user, allowing more intuitive interaction with the model in a multi-user environment. Using element borrowing, users select the elements to edit, allowing Revit to silently grant and manage ownership of the elements until the user’s next “Synch with Central” makes the edited elements available to all other users of the model.

- Worksets remain extremely valuable for data segregation, optimum workflow, and good data management, since they enable selectively opening and closing portions of a project across all project views. This level of control can represent an advantage over view-dependent features such as View Filters or Visibility/Graphics in certain workflows.

- While the capability to check out a workset remains valuable under certain circumstances outlined below, in general the best practice is to use element borrowing rather than checking out entire worksets. The Revit platform team recommends that worksets should be employed most often to segregate conceptual areas of a project, such as:
  - Separate buildings
  - Grids and levels
  - Building core
  - Building shell
  - Furniture and equipment spanning multiple categories
  - Spatially identifiable areas of a single building (wings, for example)
  - Linked RVT and DWG files
  - Room separation lines (see Rooms and Spaces section)

- Checking out a workset may occasionally be of use if certain model elements, such as the building grid or linked files, need to be protected from accidental change. In that event, BIM managers or team leaders will sometimes choose to check out the worksets containing these elements so that they cannot be casually edited or relocated.

- Worksets can help to manage element visibility to reduce visual clutter during editing, as well as Revit’s use of memory. Closing currently unneeded worksets can release allocated RAM for Revit’s use in memory-intensive tasks such as printing, exporting, and upgrading existing models to the current Revit version.

- Put links and imports into individual worksets and close the worksets when not in use.

- Use selective workset opening when opening a workshared project file.

- Close worksets not required for a given editing session.
Worksharing

- Any large project requires constant team coordination. Most customers have realized many benefits by providing teams with instant messaging (IM) software to help coordinate model editing and saving between geographically dispersed teams.

- When making significant changes in a project (moving a level or major geometry changes), it is recommended that you perform the operation when no other users are working on the file and they have relinquished all elements, then have all users make new local files.

- “Synch with Central” operations can be accelerated by a preceding “Reload Latest” command.

- When a project has been edited by other users for a day or more, it may be faster to create a new local model from the central model rather than relying on “Reload latest” to update the individual local model a day or more behind the remainder of the team.

- Attempt to keep project team workstation specifications equivalent. A dramatically weaker machine specification used by a single team member can reduce overall project performance.

- Revit saves only one local model at a time to the central file. As deadlines approach and the frequency of saving to central increases, use the Worksharing Monitor add-in to coordinate “Save to Central” commands across the team. Alternatively, team members could stagger their regular saves to central by either communicating an intention to save to central to the team or by assigning a standard saving time to each team member, i.e., at ten or fifteen minutes after the hour.

- When attempts to “Synch with Central” collide, Revit displays a dialog notifying that another user is currently saving to central. Cancelling “Synch with Central” will prevent queuing the save request, allowing the user to continue to edit the local file before another “Synch with Central” command.

- Because Revit attempts to update all open views before saving, both local saves and saving to central will increase in performance if a simple view, such as a drafting view, is the only view open when the save operation begins.

- To reduce disk usage, regularly compact central and local files.
Revit Structure Optimization and Best Practices

Analytical Model Management

If you are not using the analytical model or are not concerned about analytical model connectivity, you can disable the automatic Analytical Support Check feature which may significantly improve the performance of the model. To disable the feature, go to “R” -> Options -> User Interface, and uncheck “Structural analysis and tools”

![Image of Options and User Interface settings]

Note: To Disable the Analytical Support Check feature for a Worksharing project, please make sure to modify the User Interface setting in ALL user local computers that are working on this project.

Note: After re-enabling the Structural analysis and tools on an existing project, when opening the model or adding a new structural element again into the model, you may experience a very long delay and waiting time because Revit has to re-compute all the Analytical Check information. Once the computation is done, such delay should no longer occur.

Connection Elements

If possible, avoid excessive modeling of the 3D connections, such as connection plates and bolts, in Revit Structure. When doing typical detail, create or use 2D detail component connections instead.
Revit MEP Optimization and Best Practices

View Performance

The Model Graphics Style settings have the largest impact on performance for view manipulation operations (scroll, pan, and zoom). Due to the requirement to dynamically generate gaps and hidden lines when elements overlap in the view, the Hidden Line style requires the most processing and thus results in a noticeable performance impact in views with many visible elements. The following best practices will help to mitigate this performance impact and streamline project workflows.

Modeling and Sheet Views

To streamline project workflow, it is recommended to create both modeling views and sheet views for the same regions of the building.

Follow these guidelines:
- Modeling views should be configured to use the Wireframe model graphics style.
- Sheet views should be configured to use the Hidden Line model graphics style to produce the desired appearance for construction documentation.
- For your sheet views, use dependent views, which allow you to have multiple regions of an overall level in different views, without requiring duplicate annotations.
- Differentiate modeling views from sheet views both in the view name and sub-discipline to provide a logical organization of the view for users, and help to ensure proper usage.
- Use view templates to streamline the creation of these views and achieve consistency.
- Use duct and pipe color fills only in modeling views where the Wireframe model graphics style is used.

Optimizing Hidden Line Performance

Performance in views with the Hidden Line model graphics style enabled is directly related to the number of faces displayed in the view. Although elements display as 2D lines in a Revit view, in the model they are 3D objects made up of faces. The faces are processed by the Revit graphics system and display in the view as 2D lines. Use the following best practices to optimize the performance of views with the Hidden Line model graphics style enabled.

- Avoid using the Fine detail level when working in mechanical views unless necessary, as multi-line representations slow performance. Displaying pipes as 1-line at Medium detail level is usually sufficient when working with HVAC systems.
- If using complex 3D components in your building service designs, turn off the visibility of the complex 3D geometry in your sheet views. In place of the complex 3D geometry, use model lines that convey the overall component shape in the family definition. Make those model lines visible at the detail level defined in your sheet views.
- If not necessary for documentation when working with hidden lines in a view, setting the Mech Hidden value for Inside Gap and Outside Gap to 0 can provide substantial performance improvements.
Model Manipulation Performance

Revit MEP allows users to create models of building services, often in the form of large connected networks. The powerful analytical capabilities of Revit MEP, in conjunction with the Revit Parametric Change Engine, allow data to flow throughout the connected network when manipulations are made.

Improper structure and configuration of large connected networks has been shown to have a severe impact on model manipulation performance. In comparative testing, models have been shown to perform significantly better when structured properly.

As a connected network grows, the performance of model manipulations (such as moving elements, changing flows, and connecting new elements) is impacted by a number of factors. Understanding these factors, and adhering to the best practices outlined below, will allow for optimal model performance.

Create Systems

Create logical systems for your connected networks, rather than leaving all elements on the default system. Associating elements into systems helps to streamline data propagation and facilitates the analytical uses of systems, such as in pressure drop calculations.

Testing of customer models with all elements on the default system showed significant improvements when the connected network was restructured as logical systems.

Set Correct Connector Flow Directions

Ensure that the Flow Direction parameter for connectors on families in the connected network is not set to Bidirectional unless the family is placed in-line with connected networks like dampers and valves. The Bidirectional setting can make flow determination more difficult and thus impact regeneration performance.

Multiple Files

While maintaining the entire design for a building service in one well connected model allows for full data propagation, the size of the connected network is directly related to its manipulation performance. Testing has shown a linear decrease in manipulation performance as a connected network size grows. The rate of decrease is directly related to the topics mentioned in this section.

Because the performance of connected networks decreases with larger size, the benefits of data propagation and connectivity may be outweighed by the need for better model manipulation performance.

For large, complex buildings, the aforementioned best practices may still not provide optimum model manipulation performance. In these cases, the model should be built across multiple Revit project files.
There are two fundamental ways to structure the MEP project files: by MEP discipline or by region of the building. Both of these approaches have their benefits and drawbacks, and ultimately it is the choice of the BIM/CAD manager.

By Discipline

- This strategy creates separate project files for each MEP discipline; that is, separate Mechanical, Electrical, Plumbing, and Fire Protection files.

By Region

- This strategy creates separate project files for different regions of the building, keeping all disciplines in each file.

In order to achieve optimal coordination between the MEP disciplines, each discipline must be within the same Revit project file. This organization allows disciplines to connect to each other's elements directly, like electrical connections or drain connections on mechanical equipment. Additionally, product team testing has shown that separate connected networks do not have a significant impact on each other; a duct network does not have a significant impact on model manipulation of a plumbing network in the same project file.

Based on these considerations, it may be helpful to structure large projects by region of the building.

Simplify the Display of Architectural Elements

Simplifying the display of architectural elements may help to improve performance by reducing the visible elements that must be generated and maintained within the view. To implement this strategy, use the Detail Level setting in the view.

For example, the Coarse detail level may be applied to walls even when the view is configured to use Medium or Fine (refer to figures below). In the Visibility/Graphic Overrides dialog for the view (click View tab ➤ Graphics panel ➤ Visibility/Graphic), set the detail level of the appropriate components to the simplest level acceptable.

These settings may be configured in view templates and applied to your views to quickly simplify the detail level throughout your project.

Wall with medium detail level in medium detail view

Wall with coarse detail level in medium detail view
Interacting with Autodesk Support

When contacting Autodesk technical support services concerning performance issues, provide the following information and materials:

**A description of the issue, including:**

- When the problem began to occur (if no date is available, an approximate date is better than none)
- Whether the problem has occurred before
- Recent changes, if any, to the hardware and software of the affected machine
- A summary of any attempts to resolve the issue before contacting support

**Accompanying materials:**

- The Autodesk design files involved in the project: Local file, central file and any linked RVT, DWG and DWF files
- The Revit-based application journal file from the affected computer. See the following link for the procedure to obtain the journal file: [http://usa.autodesk.com/getdoc/id=TS1067426](http://usa.autodesk.com/getdoc/id=TS1067426)
- If a network problem or an operating system problem is suspected, obtain a System Information (NFO) file. See the following link for the procedure to obtain an NFO file: [http://usa.autodesk.com/getdoc/id=TS1057804](http://usa.autodesk.com/getdoc/id=TS1057804)